Important Rules
The projector is fragile and within easy reach of students, so please, make sure your students follow some basic precautionary rules. The department considers deliberately ignoring these rules and causing damage to the projector reasonable grounds for failure and may also bill you or a student for repairs (flying the technician in from Germany is not cheap!)

Do not touch the projector.

No food or drink in the planetarium at any time by anyone.

The projector must be upright and stationary before people move around it

There are some additional precautions when operating the projector or working in the AV room.

Food and drink is prohibited in the planetarium at all times by everyone (this means you too!) No food or drink ever at the control or near the electronics in the AV room. Food & drink are allowed in the foyer, or near the entrance of the AV room (e.g. on top of the cabinet near the door.)

Never move the projector by hand. If the projector fails to move, see the troubleshooting guide. If you cannot fix it using the guide, have the students carefully exit, write a note on the white board outside, and call for help. The phone numbers are posted in the AV room.

Make sure everyone is seated and the door closed before turning down the lights and moving the projector away from the stow position. It is low enough to walk into otherwise. Move the projector to the stow position whenever other people are moving around in the dome, including during entry, exit, and class activities.

Do not leave the projector running and unattended (see Hints & Good Practices.)

Report problems to asto-labs@umich.edu

Do not operate the projector if the temperature is over 80°F or the humidity is greater the 80%. Report these conditions immediately.
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Important Rules</td>
<td>1</td>
</tr>
<tr>
<td>Hints and Good Practices</td>
<td>3</td>
</tr>
<tr>
<td>Starting Up</td>
<td>4</td>
</tr>
<tr>
<td>Shutting down</td>
<td>5</td>
</tr>
<tr>
<td>Operating the Projector</td>
<td>5</td>
</tr>
<tr>
<td>Computer Display</td>
<td>6</td>
</tr>
<tr>
<td>Commands</td>
<td>8</td>
</tr>
<tr>
<td>Superordinate Functions</td>
<td>8</td>
</tr>
<tr>
<td>Dimming Functions</td>
<td>9</td>
</tr>
<tr>
<td>Switch Functions</td>
<td>9</td>
</tr>
<tr>
<td>Motion Functions</td>
<td>10</td>
</tr>
<tr>
<td>Special Operations</td>
<td>11</td>
</tr>
<tr>
<td>Special commands for live shows</td>
<td>11</td>
</tr>
<tr>
<td>Precession</td>
<td>11</td>
</tr>
<tr>
<td>Re-mapping the potentiometers</td>
<td>12</td>
</tr>
<tr>
<td>Calibration</td>
<td>12</td>
</tr>
<tr>
<td>Precession position:</td>
<td>12</td>
</tr>
<tr>
<td>Major Motion Calibration</td>
<td>13</td>
</tr>
<tr>
<td>Lighting</td>
<td>14</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>16</td>
</tr>
<tr>
<td>Critical</td>
<td>16</td>
</tr>
<tr>
<td>Appearance problems:</td>
<td>21</td>
</tr>
<tr>
<td>Unexpected Behavior</td>
<td>22</td>
</tr>
<tr>
<td>Rebooting the Zeiss computer</td>
<td>23</td>
</tr>
<tr>
<td>Appendix 1: Using the Computer Keyboard</td>
<td>24</td>
</tr>
<tr>
<td>Appendix 2: Seating Diagram</td>
<td>27</td>
</tr>
<tr>
<td>Appendix 3: Planetarium AV System</td>
<td>28</td>
</tr>
<tr>
<td>Logging in and Accessing files</td>
<td>28</td>
</tr>
<tr>
<td>Using the Projectors and Sound</td>
<td>28</td>
</tr>
<tr>
<td>Software</td>
<td>30</td>
</tr>
<tr>
<td>Special Equipment</td>
<td>31</td>
</tr>
<tr>
<td>Appendix 4: Canned Shows</td>
<td>35</td>
</tr>
<tr>
<td>Reporting Problems</td>
<td>44</td>
</tr>
</tbody>
</table>
Hints and Good Practices

Log your use in the logbook. This will help us figure out if there are problems (e.g. bulbs aren’t lasting long enough) and provides data when we ask for funding.

Report problems to astro-labs@umich.edu.

Before starting, make sure there is nothing that the projector can run into. It is likely to move when you start Skypost.

Always check the toolbar for errors when you start up. Also, always check the calibration after initialization. Most errors can be fixed with a reboot, followed by recalibration. See page 12 for calibration instructions.

shutdown.zkp puts the projector into a safe and expected state for running other shows as well as shutting down. All shows in the shows folder are written with the assumption that you are starting from the positions and lighting used in shutdown.zkp.

When leaving:

- If you might not be back within 2 hours, shut down completely.
- If you will be back in less than 2 hours, run shutdown.zkp completely (wait for ALL motions and the time counter to stop) but then you may leave the projector powered up and Skypost running. Make a note in the logbook in case someone else comes in.
- If you are handing off to another person, please wait until they are there, or power down completely. Unless they tell you otherwise, you should run shutdown.zkp, so the projector is in the state they expect.

Use the white lights or the cove lights for normal dome lighting. The blue light covers get hot if left on for very long.

The “All Off!” command under the control menu can be used to stop the projector, or to make sure everything is off. It does not work until initialization is complete.

If Windows crashes, turn off the main switch before turning off the PC. Report that it happened to astro-labs@umich.edu. See page 22 for complete instructions on what to do if either Windows or Skypost crashes.

The service status (shows you what’s happening on the projector) is under the Window menu. The other windows are under the Display menu.
Starting Up
1. Enter the date, time, operator name(s) and a reason in the log book
2. Look at the projector to make sure there is nothing on or around it.
3. Open the front panel on the planetarium control box and turn on the Main Power Switch.
   a. 3 orange lights should come on.
4. Turn the switch labeled Panel to turn on the control panel. The switch should light up and the panel backlight should come on.
5. Press the power button to turn on the PC. Log in as operator. SKYPOST should start automatically.
6. During initialization:
   a. a white or yellow triangle will blink on the toolbar and the projector may move.
   b. If the projector moves a little, check the calibration when it’s done and then recalibrate (see page 13.)
   c. If it moves a lot: in the Service Status window, check the DIUR.A, ANN.A, and POL.A SP positions. If it is moving appropriately to get to that position, let it go, even if it will take a long time. Report it to astro-labs@umich.edu so it can be checked, then recalibrate (see page 13.)
   d. The triangle should disappear when initialization is complete. If an error icon appears, click it to view the message. See Major Motion Recalibration on page 13 for positioning errors or the troubleshooting section beginning on page 16 for other errors. Please report the error with the text of the error message to astro-labs@umich.edu.
7. After initialization, check the calibration and, if necessary, calibrate the major motions (see page 12.)
Shutting down

Note if you’ll be back in 2 hours, or if you are handing off to another operator, do steps 1 – 3, then note in the logbook that you left the projector on, or wait for the other person to come and take over.

1. Open “shutdown.zkp”. Make sure the time pointer is at 0 or at the PAUSE at the end of the show.
2. RUN the show (see below).
3. If your audience is still in the room, please have them wait until the projector is upright before moving around the room. Turn on the cove lights and foyer light to let them exit.
4. Once the show has finished and **all motions AND the time counter have stopped**, EXIT Skypost.
5. Wait 10 – 20 seconds to ensure Skypost has saved the settings and is really done.
6. Shut down the computer (Start menu -> shut down, choose shut down.)
7. Enter the time and any comments into the log book.
8. After the computer finishes shutting down, open the front panel on the planetarium control box and turn off the Control Panel Switch and Main Switch. A couple lights under the computer will be on or blinking, but all the lights in the silver drawers should be off.
9. Turn on the operator light and (if not already on) the foyer light. Turn off the cove lights by hitting the off button. Turn off the desk lamp, In Use light and any cardinal points that are on.
10. Turn off the operator and foyer light as you leave.

Operating the Projector

Using the Control Panel

The control panel should be active (the toolbar button should automatically activate) if the Control Panel Power switch is on (see above). You can also use the mouse to operate the virtual control panel. See page 8 for a description of the control panel and the commands.

Running a show

1. Under the File menu, either select a show from the recent documents list at the bottom or choose Open and navigate to the show you want. The shows on page 35 are all in the Shows folder or its subfolders. To switch to a show that is already open, simply select it from the Window menu.
2. Make sure the Time Pointer is at the beginning of the show. If it isn’t, use the Home key on the computer keyboard, or click the EDIT 0:00 button (see page 7 for the toolbar buttons).
3. To run the show, do one of the following: click the green play button in the toolbar (“RUN” mode); use the RUN button on the control panel; Choose Run from the Control menu; or press the space bar on the keyboard.
4. In RUN mode the show runs and the Time Pointer advances. The control panel is active, even while running (but make sure you know what will happen if you use it!) Skypost automatically switches to EDIT when it reaches a PAUSE (requires user input).
5. From a PAUSE, you can use the RUN button on the control board and let the computer monitor go to sleep. You can also use JMP (see page 8) with a number to go to a LBL (check the show description.)
6. Many shows have a Reset group. You can always re-run a show after a reset, but you should run shutdown before switching shows to ensure you get the expected behavior.
Computer Display

The figure below shows the computer display. A description of each section follows.

Service Status

The Service Status window tells you what state the computer believes the projector is in, including the positions of the encoders.

The DIUR.A, POL.A and ANN.A positions are under the Main Motions folder, which should be expanded. If not, click the arrow to expand them.

All other motions are under “uncontrolled motions”. Since there are no encoders on these, they will only tell you if the computer thinks the projector is moving.

“Light Control [Dimmer]” has the dimmable lights, such as the planets.

“Switches” has the switchable lights, like YC.
Main Window, Top
The standard Windows title bar tells you the application and active show name. Under that is a standard Windows menu bar. The “?” is the Help menu. Open shows and the Service Status window can be accessed via the Window menu. The dials and virtual control panel are under the Display menu. Calibrate Axes… is under the Settings menu. “All off!” is under Settings.
The first part of the Display window should display the position of the Time Indicator (the vertical dashed line), and the next area shows the last command from the control board or software message. The … button shows recent commands, which can be selected to execute them again, but the behavior is not always what you expect. The M button shows recent software messages.

Toolbar
The first set of icons is the standard new, open, save, etc. Next is a set of icons useful in writing shows. The end of the toolbar is also shown under “starting up” on page 4. The following buttons are useful while presenting a show:
Clock: set a date and time to move the projector to.
Red arrow and square: switch to Edit mode and move to time 0:0:0.0
Yellow lines: switch to Edit mode (same as PAUSE)
Green arrow: RUN
The button that looks like a window with the control panel in it toggles the virtual control panel on and off.
The one with a green checkmark at the top toggles the panel on and off

Main Area
The show is displayed in the main area.
The column on the left is the “folder” view: the groups are displayed as folders, which can be expanded to see the cues they contain.
The wide center area is the timeline view. The dashed line is the Time Pointer. Groups are collapsed or expanded as shown in the column at the left.

Dials
These show the current position of the projector as recorded by the major motion encoders.
Sidereal time shows the sidereal time. DIUR, DIUR.A, and ANN change this.
Polar… shows the polar altitude, controlled by POL, which is also the latitude.
Time shows the date in yyyy/mm/dd format, and the local time. ANN, and ANN.A change both quickly, DIUR and DIUR.A change the local time, and change the date by 1 day per rotation.

Panel
Displays the virtual control panel. It shows the current assignment of all the control panel functions, and can be used with the mouse.
Commands
There are 4 types of functions to control the planetarium (see figure below.)

**Dimming functions** control lamps that can be any brightness

**Switch functions** control lamps that can be on or off.

**Motions** are controlled primarily by the potentiometers. The major motions (bottom row) have encoders to record their positions

**Superordinate functions** are the left-most group of buttons. They add control to the other functions

Descriptions of each command follow the figure.

---

**Superordinate Functions:**
These are controls that adjust other functions, such as changing the speed. All these functions MUST be followed by another command. The superordinate functions are:

- Numbers 1 – 12 are used with another superordinate function
- RUN runs a show
- JMP jump to a position in a show marked with a LBL (label). Also can be used in conjunction with ANN to go to now.
- V velocity (actually speed), use with the 1 – 12 keys to specify the rate for motion or dimming functions, 1 for slow, 12 for very fast. When you set a speed, that speed becomes the default until it is changed again. After a reboot, the default is V9.
- SPLIT breaks up combined functions and assigns their components to the number buttons. If a function works with SPLIT, it is noted with the function. Press SPLIT twice to undo this.
- FWD forward: set direction of motion forward. Also redundant for bring lights up.
- ACT can be used with some functions to make the “active”. If a function works with ACT, it is noted with the function.
- HOME sends the function to the home brightness or position.
- BWD backward: set direction of motion backward or turn lights down/off.
- STOP stops motion or brightness at the current position, with about a 2 second delay. You must tell it what function to stop.
Dimming Functions

**WHITE**
white lights on base. ACT WHITE causes the white light to turn on when the Sun is above the horizon, off when it’s below the horizon.

**BLUE**
blue lights on base. ACT BLUE behaves similar to ACT WHITE.

**SAT**
satellite projector, if installed on the east side – requires special set up, email astro-labs to arrange it. See Also MSAT, on page 10.

**COM**
same as SAT but for the west side See Also MCOM, on page 10.

**MAP**
not available on our system

**NAU**
nautical triangle (MER VERC and HOUC).

**CON**
constellation figures for the north and south, or the precession scale in the north – see Precession on page 11.

**ZOD**
zodiac constellation figures

**MER**
meridian

**EQU**
equator

**ECL**
ecliptic

**HOR**
horizon lights, on base. HOR will turn on/off the appropriate light based on the position of the Sun. SPLIT HOR releases HORE and HORW, which can be used to keep the horizon lights on or off.

**PLAN** (virtual panel) or IPLAN (physical panel) planets – turns the planets on only if the Sun is not on and above the horizon. SPLIT PLAN gives access to OPLAN and IPLAN, which will keep the planets on even if the Sun is on. It also assigns control of individual solar system objects to the number keys thus: 1: Mercury; 2: Venus; 3: NA; 4: Mars; 5: Jupiter; 6: Saturn; 7: NA; 8: NA; 9: IPLAN (inner planets); 10: OPLAN (outer planets); 11: ANN.A (see Major motions, page 10) 12: year counter.

**SA**
Saturn

**JU**
Jupiter

**MA**
Mars

**SU**
Sun

**MO**
Moon

**VE**
Venus

**FIX**
fixed stars

**MW**
Milky Way – comes on with FIX but is independently controllable

**SOSY**
solar system objects – turns on planets, Sun & Moon whenever they are above the horizon.

**ME**
Mercury

Switch Functions

Note The motions of HOUC, VERC, and PRSC are controlled through a minor motion potentiometer.

**HOUC** (hour circle: red line going through the NCP)

**HOUSC** (hour angle scale: scale centered on NCP)

**PRSC** not available

**AZISC** (azimuth scale: scale centered on zenith)

**VERC** (vertical circle: green line going through zenith)

**YC** (Year counter)
Motion Functions

Major motions (bottom row of knobs)
These control the motion of the projector. There are multiple options for their behavior
Press SPLIT ANN to access the .A options, which are necessary for calibration. **Use the virtual control panel to see which function is active, and which number each motion is assigned to.** Assign the potentiometer to the .A function by pressing the potentiometer button, then the corresponding number key. For example: SPLIT, ANN, DIUR, 4 assigns the DIUR potentiometer to DIUR.A.

- **DIUR** diurnal (daily) motions. Changes the Sidereal time, which also affects the local time. Rotation of more than 24 hours also causes ANN to advance one day.
- **DIUR.A** Same as DIUR, but does not change the dials or SP reading under the Service Status.
- **ACT DIUR.A** causes the projector to move until it matches the dial reading.
- **POL:** polar motion (latitude control). Forward/right takes you north as far as the north pole; backward/left takes you south as far as the south pole.
- **POL.A** polar motion without limits. Does not change the Polar altitude dial. Use **ACT POL.A** to return to the position on the dial.
- **ANN** annular motion sets the planets, Sun and Moon in motion (date and local time control)
  with the local time held fixed (the Sun, if above the horizon, will trace the analemma.) The date and sidereal time change. Note these will also move with the Diurnal motion at their normal rate (i.e. the Sun will move about 1° when the diurnal motion makes 1 full rotation)
- **ANN.A** sets the planets, Sun and Moon in motion at a fixed sidereal time. None of the dials change. ACT ANN moves the projector to the time on the dials.

Minor motions (top row of knobs):
- **HOUCA** moves the hour circle
- **VERCA** moves the vertical circle
- **PREC** demonstrates precession. This is disabled by default. See Re-mapping the Potentiometers on page 12. If you use this function, you will have to re-align the projector afterwards. See Precession, the next section.

Other motions:
- **MSAT** controls the motion of the satellite projector when mounted in the east. The satellite projector can only move in a straight line starting from a fixed point determined by how it is mounted. FWD is CCW. MSAT can be assigned to a potentiometer (see page 12) but since satellites normally move at a steady speed it is generally better to control it using the superordinate functions. This projector requires special set up in advance – email astro-labs to arrange it.
- **MCOM** is the same as MSAT but for west side installation.
- **AZI** – not applicable to our machine
- **LON** – adjust the observer’s longitude. This allows you to change the sidereal time without changing the local time. Note the audience can’t tell the difference between this and DIUR. HOME LON returns you to Ann Arbor.
Special Operations
Special commands for live shows

Now:
During a live show, JMP ANN will move the projector to right now.

Automatic lighting:
ACT WHITE or ACT BLUE will cause the white or blue lights on the base to turn on and off automatically used on the position of the Sun. ACT FIX does the same for the stars.
Note that HOR (E & W horizon lights) and PLAN (planets) behave this way normally.

“locking” the superordinate functions:
If you press a superordinate function button twice, it will remain active. For example BWD BWD locks the backward command, so you can now press FIX, JU, and ME to turn off the stars, Jupiter and Mercury without having to hit BWD in between. To disable, hit any other superordinate function (STOP is a good one). It will also return to the default FWD if it isn’t used for about 20 seconds.

Satellite projector:
This projector is not permanently mounted. To request to use it, email astro-labs with the date you want to use it and the path the satellite should follow.

Precession
To demonstrate precession:
Move to a mid latitude, like Ann Arbor. Set the sidereal time at 6h or 18h (6h puts the current year on the MER and above the horizon in A2.) Turn on whatever lamps you want on (ZOD, FIX and MER are usual)
On the north starball, switch the silver toggle switch near the MW projector to turn off the constellation projector and turn on the precession scale.
On the south starball, switch off the constellation projector with the silver toggle switch near Canopus & the MW projector (see image, right.)
Turn on the precession scale using CON.
Push SPLIT PREC, PREC 1 to activate the potentiometer. The virtual control board should indicate that the potentiometer controls PREC.M.
Use the potentiometer to move the precession
When finished:
See the Calibration section on page 12 for returning the projector to the current epoch
Return the toggle switches on the starballs to the correct positions for the constellation projectors.
Re-mapping the potentiometers
To re-map the potentiometer to a different function
  Press the button next to the knob once
  Press the function you want to control with the knob
To reset the potentiometer to the original function
  Press the button next to the dial twice

Example
  Press the VERC.A button once
  Press the SU button once.
  The potentiometer next to the VERC.A button now controls the brightness of the Sun. Turning the knob to the right turns the Sun on to a brightness proportional to how far you turn the knob. The center position is off. Turning the knob left does nothing
  Press the VERC.A button twice (slowly!)
  The potentiometer now controls the motion of the vertical circle again.

Notes:
  Restarting the Zeiss computer resets the potentiometers
  PREC is off when you boot the computer, so you have to “re-map” it to turn it on.
  Switches cannot be assigned to the potentiometers.

Calibration
Precession position:
Move to a mid latitude, like Ann Arbor.
Turn on: EQU, ECL, FIX, ZOD and CON.
If you see the precession scale instead of the constellation figures, flip the switches on the starballs (see pg. 11.)
Use DIUR to bring the figures of Taurus and Leo up (around 6h ST).
If the PREC knob is not already active, press SPLIT PREC then PREC 1 to activate it. Use PREC.M to move the figure of Orion to be east of Taurus and move the stars of the zodiac to the correct figures.
Refine the position using the stars of Orion and Leo:
  In Orion, the westernmost/northernmost belt star (Mintaka) should be at 5h 32m and just below the equator.
  In Leo, Regulus should be near the ecliptic just a bit after Aug 23.
If you are going to continue running the projector but not demonstrating precession, assign the PREC potentiometer to something else so you don’t accidentally move it (see re-mapping the potentiometers on page 12.)
Press SPLIT SPLIT to set the number buttons back to just numbers (no second functions.)
Major Motion Calibration

1. Run calibrate.zkp, or: Make sure the following lamps are on: EQU, ECL, MER, YC, SU. It is useful to assign SU to a potentiometer, and to move to a middle latitude with the Sun above the horizon.
2. Press SPLIT ANN. The virtual control board should show that some of the number buttons are now also .A (“astronomical”) motions.
3. Press STOP 1, STOP 3, and STOP 4. This ensures the .A motions are truly stopped and separated from each other and any other motions.
4. Press DIUR 4 to make the potentiometer control DIUR.A (see Re-mapping the potentiometers, p 12). Check the virtual control board to make sure the reassignment happened. Press POL 3 to make that potentiometer controls POL.A. Press ANN 1 so that potentiometer controls ANN.A.
5. Adjust DIUR.A and POL.A to a reading that is actually convenient. Make sure the Sun is above the horizon. It is nice to have one of the hour lines on the equator align with the meridian, and to have the equator cross the meridian at 45º above south (make sure the numbers are right side up). Adjusting ANN is not usually required.
6. Get the actual position of the projector:
   a. Read the position on the equator where the meridian crosses it. This is the sidereal time, or DIUR.A position. Note you will need to translate the time to degrees. E.g. 6:00 ST = 6.0h/24h * 360º = 90º
   b. Read the position on the meridian where the equator crosses it. Subtract the reading from 90 to get the latitude. This is the POL.A position.
   c. The year counter and position of the Sun on the ecliptic gives the date. If you can’t see the ecliptic, make the Sun a bit dimmer. Note: calibration may not be able to correct differences smaller than 2 days.
7. Open Settings -> Calibrate Axes…. 
   a. To change a position, click its name and enter the position you read off the dome in the box at the bottom of the window. Repeat for all the positions you need to change. Don’t forget DIUR needs to be in degrees, not time.
   b. Click ok, then click ok again in the message window that pops up.
8. Wait 5 seconds for the computer to complete its updates and “check in” with the encoders.
9. Next, have the projector move to the positions indicated on the dials:
   a. Press ACT 3 and wait for the projector to move to the correct position. If it arrives at the correct position, press POL POL so the potentiometer goes back to the normal polar motion control.
   b. Press ACT 1 and wait for the projector to move. If it’s correct, press ANN ANN.
   c. Press ACT 4 and wait. If it’s correct, press DIUR DIUR.
10. Check the calibration. If the projector did not move to the correct positions:
    a. Check to see if the SP and AP positions are the same. If they are, make sure the potentiometers still say .A, and start over from step 5.
    b. If they are different, wait to see if they are still moving (check the line ending Inkr). If they are still moving, report it to astro-labs while you wait for it to finish moving, finish these steps, restart (see page 22), and try recalibrating again. Please also let astro-labs know if the restart fixed it by either waiting to send the email, or replying to the ticket.
    c. If they are different but it’s not moving (not even a a rate of 0.1º per 5 seconds), report it to astro-labs. Try restarting and recalibrating, or shut down.
11. Press SPLIT SPLIT to set the number buttons back to normal.
Lighting
With the projector off, dome lighting is controlled by the switches on the side of the operator’s station.

The cardinal points are individually controlled from a set of rheostats. There is a stop for off and full on, but you can force it to move further, so be careful with these. The lighted red switch controls the “In-Use” light outside the door. The operator light is the one behind the desk. The foyer light is the star shaped light in the entryway. Both these lights have two switches, one at the desk and one next to the door. The operator light provides minimum lighting for the dome until the cove lights can be turned on. The projector shut off is used to turn off the circuit for projector maintenance. It should only be shut off if there is something wrong. Check the whiteboard in the AV room or use the contacts under Reporting Trouble on the back cover if you think the power is off.
The **cove lights** are controlled from the push button panel. There are several options, including several color presets and fade-in controls. The current configuration is shown below.

<table>
<thead>
<tr>
<th>Button #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fade in White</td>
</tr>
<tr>
<td>2</td>
<td>Fade in city lights orange</td>
</tr>
<tr>
<td>3</td>
<td>Red</td>
</tr>
<tr>
<td>4</td>
<td>Rainbow</td>
</tr>
<tr>
<td>5</td>
<td>Fade out white to 0%</td>
</tr>
<tr>
<td>6</td>
<td>Fade out white to faint city light orange</td>
</tr>
<tr>
<td>7</td>
<td>AV projector setting</td>
</tr>
<tr>
<td>8</td>
<td>Maize&amp;Blue</td>
</tr>
</tbody>
</table>

When one of the lighting programs is running there is an orange light next to the button. You should turn it off with the off button before leaving so they don’t come back on again in a few hours. When they are really off, no orange lights are on.

If you adjust the brightness, be sure to bring the lights back up to full before you leave.
Troubleshooting
Critical
Planetarium won’t start/run

- Is there power to the projector? (the main switch should light up when turned on)
  - Yes
    - Is the CAN interface on (3 orange lights in Starting Up step 3.a on page 4.)
      - Yes
        - Is the computer running?
          - No, it won’t boot
            - Shut Down the planetarium and report the problem to astro-labs
          - No, it crashed
            - See Rebooting the Zeiss computer on page 23
      - No
        - Is Skypost running?
          - Yes
            - No, it didn’t start
              - Report the problem (this isn’t normal behavior). Try to start it by double clicking the “Star Control” icon on the desktop. If it won’t start, see Rebooting the Zeiss computer on page 22.
          - No, it crashed
            - See Control Panel Doesn’t Work on page 19.
        - No
          - Does the Control Panel respond (check computer display)
            - Yes
              - Yes, but not as expected
                - See Projector Doesn’t Move on page 18.
              - No
                - See Projector Doesn’t Move on page 18.
            - No
              - Can you run a show?
                - Yes
                  - If a show is open but won’t run, see Show won’t Run on page 19. If Skypost looks fine but is not responding, treat it as if skypost crashed, page 22.
              - No
                - See Control Panel Doesn’t Work on page 19.
Projector Moves Unexpectedly/Uncontrollably

Did the motion begin during initialization/right after start-up?

Yes → Open the Service Status window if not already open. Check the AP and SP lines for the appropriate motion(s). Is the AP getting closer to the SP?

No → Are there any error messages?

No → Let it go. Report it to astro-labs. Recalibrate (page 13) Then restart (page 23)

Yes → Does “All Off” under the control menu work?

No → Shut down. Use the phone list to call someone, or report the problem to astro-labs

Yes → Try running shutdown.zkp. If it behaves normally, check the calibration and recalibrate if necessary. If it doesn’t behave normally, or if you don’t think anything you did would have caused it to run away, report the problem and try rebooting.

No → Is it an error you can fix?

No → Is it an error you can fix?

Yes → Go ahead and fix it. Report what happened to astro-labs. See page 23 for rebooting the system.
Projector doesn’t Move

Is the system on and operational (e.g. you can turn lights on and off) [Yes] [No]

No → See Planetarium won’t start/run above, page 16.

Yes → Are both the control panel and keyboard/show cues affected? [Yes] [No]

No → Check the superordinate section of the virtual control board to see if any of the motions are assigned to the number buttons. Check the Service status to see if the ACT line for the problem motion(s) says Independent. If either thing is true, recalibrate (page 13.)

Yes → Does the computer display indicate commands are being received (see page 6)? [Yes] [No]

No → See Control Panel doesn’t work, page 19.

Yes → Check the virtual control panel to make sure the potentiometers are assigned to DIUR, POL, and ANN.
- If any are assigned to the .A motion, recalibrate (see page 13.)
- If they are assigned to something else, push the button twice to set it back to the correct motion.
If it looks like it should be working right, report the problem and try restarting, page 23.

If you are trying to run a show, see Show won’t run, page 20.
If you are using the keyboard:
1. make sure you have a green smiley and are clicking Execute (not OK or Cancel).
2. Use the control panel.

Keyboard/show only

Control Panel only
Control Panel Doesn’t work

Is the backlight on and the panel active? (See Starting Up step 0 on page 4.)

Yes

No, only one is affected

Turn the switch on and make sure the panel Active button is on (see page 5)

No

Is the computer receiving the commands (see Computer Display on page 6)?

Yes

Are all commands affected?

Yes

No, but more than one

No

Report the problem. Try rebooting the computer (see page 22.) If you can work around it (using the keyboard or not using the affected commands) do so. Otherwise shut down.

No

Is Skypost still working (can you run a show or enter commands through the keyboard)?

Yes

Reboot the computer (see page 22.)

No

Reboot the computer (see page 22.)

Didn’t work

Shut down and report the problem

No

Is Skypost still working (can you run a show or enter commands through the keyboard)?

No

Reboot the computer (see page 22.)

Shut down and report the problem

No

Turn the switch on and make sure the panel Active button is on (see page 5)

Yes

Are all commands affected?

No

Yes

Report the problem. Try rebooting the computer (see page 22.) If you can work around it (using the keyboard or not using the affected commands) do so. Otherwise shut down.

No

Is Skypost still working (can you run a show or enter commands through the keyboard)?

No

Reboot the computer (see page 22.)

Yes

Is there any error message (esp. a triangle at the end of the toolbar)?

No

Yes

If it is something you can fix (like a position error), go ahead and fix it. Otherwise, report the problem (include the error message!), and try rebooting. If rebooting doesn’t work, you’ll have to shut down.

- If one (or more) of the motions is affected, see Projector doesn’t Move, page 18 (unless you came from there).
- If it is a single lamp or function, see Missing or Wrong stars/lines on page 21.
If you have already tried those, restart the system, page 23.
Show won’t run

Is the run button in the toolbar green? Yes

Is the time counter at 0? Yes

Set the time counter to 0 by doing one of the following:
- Click the red EDIT 0:00 button in the toolbar (see page 7.)
- Click in a blank area in the program window (see image on page 6), then use the home key on the keyboard
- Click and drag in the program window (be careful not to select any cues)
- Close all shows (not Skypost) and reopen the one you want
Run the show (See page 5.)

Are the EDIT 0:00 or PAUSE buttons also grey? Yes

Is there an error message you can fix? Yes

- Operate from the control panel if it is still working and you can do what you need to do
- Restart the Zeiss computer (page 22) OR
- Shut down and report the problem

Hit the EDIT 0:00, then hit RUN.

Doesn’t work

No

Go ahead and fix it.

No

No
**Appearance problems:**

**Missing or Wrong stars/lines**
- If a single lamp is out, report the problem. You cannot change the lamps yourself (and it may be a fuse, control board, or several other things). Note many functions have multiple lamps, so if the whole thing is out (e.g. both N and S stars or the entire equator), that’s a different problem, and you should keep reading.
- If there an entire function won’t work (e.g. the entire equator, or all the planets controlled by OPLAN), see “something doesn’t turn on/off” on page 22.
- If there is a small section missing:
  - Check to see if the light is hitting the projector somewhere (e.g. there is a shadow of the Canopus projector in the southern Milky Way). There is nothing you can do about this.
  - If it is near the horizon, it is probably a gravity shutter. Rotate the projector so what you are trying to look at is higher in the sky. If it seems really sticky, report the problem.
- The wrong thing appears when a button is pushed
  - If CONST is pushed and the precession circle appears, the toggle switches on the starballs need to be switched back. See Precession on page 11.
  - Check the virtual control panel to see if any buttons have been reassigned.

**Stars/lines/etc in the wrong place**
If any of the following issues are the problem, the precession motion needs to be calibrated (see Precession Motion Calibration on page 12)
- Polaris is not at the north celestial pole
- The zodiac stars do not match the ZOD figures
- Stars (e.g. Canopus) that shouldn’t be visible from A2 are visible
- Stars (e.g. the handle of the Big Dipper) that should be circumpolar aren’t circumpolar

If any of the following issues are the problem, the major motion needs to be calibrated (see Major Motion Recalibration on page 13.)
- The position of the Sun on the ecliptic doesn’t match the date on the Time [UT…] dial.
- The sidereal time dial doesn’t match the RA on the meridian
- The elevation of Polaris doesn’t match the polar dial
- There is a blinking yellow or red triangle on the toolbar that, when you click on it, says recalibration is necessary.
- The planets or moon are widely out of place (e.g. a full moon when it should be a crescent)

If any of the following things are the problem, check for one of the other issues above to determine which thing needs to be calibrated.
- The wrong stars appear for the season
- The wrong stars appear for the time of night
- The Sun is up during what should be nighttime
Something doesn’t turn on/off
If the projector spontaneously starts moving or turning lights on and off, see Projector Moves Unexpectedly/Uncontrollably on page 17.
Make sure you are telling it to do something it hasn’t already done (e.g. if the white lights are on, pressing WHITE won’t do anything.)
If it is a single lamp or a single function, see Missing or Wrong stars/lines on page 21.
Make sure it should be working. For example, if PLAN is active and the Sun is above the horizon, the planets will not turn on. See Automatic Lighting under Special Operations on page 11.
Determine if it is the way you are entering the command.
- Control panel: remember it must be active (see page 5), and if you are trying to turn something off you must push BWD first. If the computer receives the command it will show it on the computer display (see page 6.)
- Keyboard: a properly formatted command will get you a green smiley-face. Click “Execute” to run the command. See page 24 for full instructions.
Check to see if the other method will work to enter commands (i.e. if you are using the control board, try the keyboard.) If it is just the control panel, see “Control Panel Doesn’t work” on page 16. Otherwise, restart the Zeiss computer (see page 22.)

Unexpected Behavior
Skypost/Windows problems

Skypost crashed
- If the control board still works (and can be used for what you are doing), continue to use it, then reboot the computer at a convenient time (see below)
- The skypost icon is on the descktop (labeled “Star Control”). You can try to restart skypost by double-clicking it, but this usually doesn’t usually work.
- If the control board doesn’t work and you can’t restart Skypost, you’ll have to reboot (see below)

Windows crashed
- Report the problem. See below for instructions for rebooting the computer.

Control Panel Problems
If the potentiometers change something other than what they’re supposed to (e.g. white lights come on when DIUR knob is turned, see Re-Mapping the Potentiometers on page 12.
If several functions aren’t working, check the virtual control panel to make sure buttons are assigned normally. In particular, make you haven’t “Split” functions. If you have, press the Split button twice to fix it. If any of the major motions were affected, check the calibration.
Otherwise, see “Control Panel Doesn’t Work” on page 16.
Rebooting the Zeiss computer

If you can shut down the computer normally:
1. Exit Skypost if it is still working. Count to 10 to make sure it has saved all its settings.
2. Shut down the computer.
3. If you are rebooting to fix a problem, turn off the Control Panel Power and Main Switch.
   Count to 10, and then turn them back on.
4. Go through Starting Up starting from step 4, paying special attention to step 6 (It is
   common for the calibration to be wildly off if things are not shut down or started
   normally.)
5. Report the problem, especially if you had to recalibrate because the positions were wildly
   off.

If Windows crashed or you can’t shut down normally:
1. Turn off the green Main Switch
2. Push and hold the power button on the computer (see the figure in Starting Up on page 4.)
   Make sure it shuts down, not just sleeps (count to ten and make sure all activity and power
   lights stay off.)
3. Turn off the Panel switch.
4. Turn on the Main Switch. It MUST be on before Windows starts.
5. Go through Starting Up (page 4) starting from step 4, paying special attention to step 6 (It
   is common for the calibration to be wildly off if things are shut down or started normally.)
6. Report the problem, especially if you had to recalibrate because the positions were wildly
   off.
Appendix1: Using the Computer Keyboard
THIS HAS NOT BEEN UPDATED FOR THE NEW SYSTEM! USE WITH CAUTION!

This is actually the first step in writing shows for the planetarium. It is provided here as reference since it is sometimes easier to enter commands via the keyboard than the control board. If you want to actually learn to write shows, please see Shannon about getting the complete training and a directory to save shows to.

The **basic steps** to issue a command from the keyboard are:

1. Type the first letter of the function. A dialog box appears with a list of commands starting with that letter.
2. Select name of the command.
3. Select the other options such as position, direction, and speed. See below for all the options.
4. If the option requires a number, such as a time, highlight the number range in the text box and type the correct number.
5. If the command is complete and formatted correctly, a green smiley face appears. If the command is incomplete, a yellow flat face appears. If there is something wrong, a red frown-y face appears.
6. To run the command, click the “Execute” button.

All of the functions are listed in the section “Commands”. The available options vary depending on the type of function. The options are similar to the superordinate functions used when running via the control panel, however there are some important exceptions.

The function name plus all the options, ready for execution is called a “cue”.

All functions can have a home setting. Usually home is off. Some special exceptions are listed below.

The following abbreviations are acceptable: F for FWD, B for BWD, H for HOME, S for STOP.

**Switch functions**

On or off only. There is no direction or speed setting for switch functions.

Examples:
- YC ON turns the year counter on.
- YC FWD is not valid (no direction allowed)
- YC H V6 is not valid (no speed allowed – YC H is valid))

**Dimming functions**

These can have multiple settings for position and speed. In this case, position is a reference to the lamp voltage. Direction can also be specified if the position is not given as an absolute reference.

# is a reference to an absolute value. It is followed by a number 0 (for off) through 100 (full on). Direction cannot be specified.

% is a reference to a relative value. It is followed by a number 0 (for no change) through 100 (full on). It will add or subtract this value to the current setting based on the specified direction. If no direction is specified, FWD is assumed.

Directions can be given as FWD to increase voltage (add for %), BWD to decrease voltage (subtract for %) or STOP to stop the voltage from changing.

**Examples:**
- BLUE F V12 turns the blue lights on quickly.
BLUE STOP stops the lights at their current voltage (useful only if the lights are coming on or turning off.)
BLUE #25 turns the blue lights to 25% of their maximum, no matter what their current setting is.
BLUE #25 F V6 is not valid (no direction allowed with #.)
BLUE %50 increases the voltage by 50% of the maximum.
The sequence BLUE #25 V12 followed by BLUE %50 will adjust the blue lights to 25% on as quickly as possible, then increase to 75%, also at speed V12.
BLUE #25 V12 followed by BLUE %50 BWD V2 will turn the blue lights on to 25% quickly, then turn them back off very slowly.

**Minor motions (MPREC, VERCA, HOUC.A):**
Direction and speed only. There are no encoders on these projectors, so the computer doesn’t know how far they’ve moved.

Examples:
- VERC.A moves the vertical circle forward at the default speed
- VERC.A F is the same thing
- VERC.A B V5 moves it backward at a medium speed
- VERC.A %25 is invalid

**Major Motions (DIUR, ANN, POL)**
These can have almost any setting.
STOP will stop the motion.
Other options vary depending on which motion is used.

**DIUR:**

- # or % must be followed by time in h:mm format. # will move to a specific local time, % will move the specified number of hours and minutes FWD or BWD. If no direction is specified, FWD is assumed.
  - HOME is normally set to 0 or 12 hours, the two safe positions to move to if people need to move around.
  - NOW can be used to move to the current local time, based on the computer’s clock. See the note before the examples about using the special time settings.
  - LT stands for local time, and should be followed by a time in h:mm format. See note below.
  - ST stands for Sidereal time, and should be followed by a time in h:mm format. See note below.
  - HORE, HORW and MERIDIAN can be used to set the projector to a time relative to when the sun will rise, set, or transit, respectively. It may be followed by an offset in ±h:mm. See note below.
  - ANALEMA can be used in conjunction with ANN F to demonstrate the analemma. You can also specify an offset time in ±h:mm.

**ANN:**

- # moves to a specified date, and must be followed by an actual date in YYYY/MM/DD[.D] format (the fraction of a day is optional, and is measured from UT).
  - % moves the specified number of days, from 0.1 – 999.9 and should include a direction.
  - HOME or H is reset at the beginning of each semester and will take you to a date before the first full moon, so the moon phase should be accurate.
  - NOW takes you to today, according to the computer clock. See note below.

**POL:**
# takes you to any latitude between –90 and +90 degrees. Note the computer will accept values between –180 and +180, but that could put the north star in the south with our set up.

% moves a specified number of degrees in the specified direction. If no direction is given, FWD is assumed.

HOME is set to Ann Arbor (42ºN.)

**Note on special time settings**
The special time settings (like NOW or SUNSET) are calculated based on the Skypost settings at the moment the command is issued. This includes the date, time and latitude. If the projector is set to Aug 10 in Ann Arbor and you issue a DIUR SUNSET cue, then an ANN NOW cue, the projector will move to today’s date, but the time will be sunset on Aug 10. If you issue a DIUR SUNSET cue then POL # -42 the projector will move to -42 degrees S, but the time will be sunset in Ann Arbor. If the projector is moving in ANN when you issue the DIUR SUNSET cue, it will calculate sunset for the date it happened to be on at the moment it got the DIUR SUNSET cue, which is probably not what you wanted.

The best way to ensure the projector does what you want is to issue the cues in the order POL, ANN, DIUR, and let each cue finish executing before issuing the next command.

The positions MERIDIAN and ANALEMA are calculated as positions, not times, so the projectors will move to keep the Sun in the correct position. DIUR MERIDIAN followed by ANN % 30 will cause the Sun to move 30 days on the ecliptic and the DIUR will move to put the Sun back on the meridian. The DIUR will continue to try and put the Sun back on the meridian until another DIUR command is issued, either as a cue or from the control board.

Examples:

- DIUR #2:00 will move the projector to 2 hours sidereal time in whichever direction is shortest at the default speed.
- DIUR %2:00 moves forward 2 hours in sidereal time.
- DIUR LT2:00 F moves forward to 2(AM) local time (probably tomorrow.)
- DIUR ANALEMMA+6:00 will demonstrate the changes in the position of the Sun 6 hours after the analemma position (around Sunset) after you issue an ANN F cue.
- ANN #2007/01/03 V12 moves to Jan 3 2007 as fat as possible.
- ANN NOW V12 moves to today’s date.

The series POL H V12; ANN NOW; then DIUR SUNSET+2:00 will move to 2 hours after sunset today, as long as you wait for each cue to finish before executing the next one.
Appendix 2: Seating Diagram
Seating chart. Folding chairs can be used if there are no wheel chairs.
Left handed seats are marked
Appendix 3: Planetarium AV System

This system includes three digital projectors plus a pair of speakers above the dome. It can be used without turning on the planetarium star projector. The projectors (format 1024x768 pixels) are located under the cove lights and are arranged to project three images roughly equally spaced places on the dome with the star projector in the home position. Please don’t attempt to move or adjust these projectors.

Make sure people are seated before turning on the projectors. These projectors are very bright, and people could damage their eyes by looking directly into them.

The computer is kept in the AV room. You’ll need to go in there to insert a CD, DVD, or other media. There is a USB hub on the control desk in the dome. There are USB3 ports on the computer (the blue ones).

Logging in and Accessing files

Log in with your uniqname and Kerberos password.

The folders on the desktop the first time you log in are shared folders, in the “Public Documents” folder. You can add files, which will be available to other users, and occasionally backed up and added to the Astro Instruction Archive.

You can also add files and folders to your My Documents, which will not be shared or backed up.

Box Sync and Google Drive are both installed, but will not run automatically. Access both from the Start menu.

Using the Projectors and Sound

Audio

- The master volume is adjusted by the black dial on the desk.
- To use another device (iPod, laptop, etc), connect the device to the audio input cable on the desk. The cable fits a standard headphone jack.
- All inputs are mixed uniformly, so you may want to mute the computer when using another device.
- See below for playing audio from Real Player, Windows Media Player and other applications.
Projectors
- Use Cove Light setting 7 if you want the lights on with the projectors.

- The software is actually called “Projector Station for Network Control.” You can open it with the shortcut called “Projector Control” on the desktop. You may wish to right-click and choose “Pin to taskbar” to make it easier to get to in the future.

- Click on the open button or File and open *Documents/AVprojectors.ncp* (should be number 1 at the bottom of the menu in the usual Windows location for recent documents)

- Click the Planetarium folder in the Group area to load them into the Projectors area.

- If you are unsure of the projector status at any time, click the update button.

- With the folder still selected, click **ON**. If you only want to turn on one projector, select it from either list first. It will take ~15 seconds before video is displayed, ~35 seconds for full brightness.

- Click the Planetarium folder then **Off** to turn the projectors off. Click the update button if they don’t say “Cooling” under Power. If only one says cooling, click the folder again and click OFF, or select each projector individually and click OFF. They must say “cooling” before you log out or they will stay on. It takes almost 60 seconds for them to turn off completely. Therefore if you wanted to turn the projectors off, then on, this could take a full minute and a half.

- To use the projectors with the second connector (e.g. with a laptop), select each projector and click “Input A.” The software only supports changing inputs one projector at a time. Please make sure to set it back to input C before you log out.

- If an app is left on the projector, mouse over the icon in the taskbar, right-click on the preview, and select “Move”. Hold the left arrow key until it appears on the monitor.
Software

PowerPoint
- If you didn’t open PowerPoint by opening a slideshow, open your PowerPoint document from the File tab of the ribbon.
- Before you run a show for the first time, click the “Slide Show” tab in the ribbon. Check “Use Presenter View”, and make sure “Show On:” is set to Monitor 3 Generic PnP Monitor.” That should be the default the next time you open PowerPoint.

- Turn on the projectors (see above).
- Select “From Beginning” or “From Current Slide” from the Slide Show tab.
- The show should run on the projectors with the presenter screen on the monitor.
- See Also PowerPoint under Graphics Tablet, below.

Playing DVDs
- Turn on the projectors.
- Insert the DVD into the drive in the AV room.
- If it is just a video disk, it should open automatically with Windows Media Player. If it is a DVD-ROM, you may have to tell it to play media. Alternatively, you can tell it to open the file explorer and browse to the material on the DVD.
- If necessary, grab the title bar and move it off the right side of the screen onto the projectors.
- There is a button in the lower right for full screen mode.
- Click play on the controller to play the DVD.
- To use the DVD menu, you’ll have to move the mouse over to the right to the projector screen.
- Don’t forget to eject the disk when you’re done.
- If you always use the projectors with Windows Media Player, you can leave it on the projector window (see the end of the “Projectors” section above if you need to move it.)
Web browsers, Real Player, Windows Media, and other applications

- If you need them, turn on the projectors (see note below.)
- Open the application or the file you want to play. If you are using a browser, browse to the page you want.
- For audio only files, you should be able to click play, and adjust the volume using the dial on the desk. If you cannot see the application, see the note below.
- For files that you want to project, change the window to the size you want it to be. Note that full screen mode in Real Player and Windows Media Player doesn’t work on the projectors.
- Click on the top bar of the window and drag it to the right until it is displayed on the projectors. If it won’t move, click the button on the top right that looks like 2 overlapping windows.
- You can now play your media.
- Drag the window back to the monitor when you’re finished.

PLEASE NOTE: if you close the application with the window displayed on the projectors, the window will open on the projectors next time. If the projectors are off, this means you won’t be able to see the application, so please drag the window back onto the monitor before exiting the application. If the application opens (appears in the taskbar) but there is no window, mouse over the icon in the taskbar until you get the preview. Right-click and select Move, then use the left arrow to bring it back to the monitor.

Special Equipment

Assisted Listening Device
This picks up the audio from the amplifier (the sounds that come from the speakers) as well as the sounds from the microphone. The microphone does NOT go through the amplifier.

We use frequency C.
Check the headphone pads for damage or dirt. Turn on and adjust the volume using the dial on the top.

To have your voice also go through it, turn on the microphone by moving the switch all the way over to “on”.
The batteries in the units do not last long. If there is no signal, replace the batteries.
The tablet can be used in several ways, detailed below. How it can be used depends in part on what part, buttons, pen or mouse, you are using. You MUST use either the pen or tablet mouse with the tablet. With the extended display, the right half of the tablet is the projector display, and the left half is the monitor. This is especially important to remember when using the pen.

**Attaching the tablet**
Plug it into the white mini-usb cable on the desk. It does not matter if the computer is on or off, logged in or not, but if it is logged in it will need about 2 seconds to recognize the tablet.

**Disconnecting the tablet**
Disconnect the mini USB. Please store the tablet in the back room so it can’t disappear or be damaged while not in use.

**Tutorial and Users Guide**
Go to Start -> All Programs -> Pen Tablet to access the User’s Manual or Tutorial. You can also get to the tutorial from the Properties, but please do not change anything in the there or remove the preferences, since that could confuse users after you.

**Using the Mouse**
The mouse, for the most part, acts like a mouse except it only works over the active area of the tablet. You can left or right click and use the scroll wheel like a regular mouse. Pressing the scroll wheel acts as a middle click for applications that use a middle click. The disadvantage is that the mouse only works when it is over the active area on the tablet, which is a lot less space than the regular mouse. However, the tablet doesn’t have to sit on the table, and it doesn’t have any problems with lumps like the joint between desk sections.

**Tablet Buttons**
The buttons have been left on the default setting.
- The < button is “back”
- The > button is “forward”
- The FN1 button is Show Desktop
- The FN2 button is Application switcher
- The touch ring (inside the glowing blue circle) acts as a zoom: CW is zoom in and CCW is zoom out. The up arrow on the touch ring will act like the “Page Up” key and the down arrow like “Page Down”.

**Using the Pen**

![Pen Diagram]

There are two very important things to know about using the pen:

1. The tablet area is mapped to the screen, so the upper right corner of the tablet is the upper right corner of the projector area.
2. The pen does NOT have to touch the tablet.

The narrow nib is the normal “down” end of the pen, and the wide top is the “eraser”. All instructions assume this is the orientation, although for most applications it doesn’t actually matter which way you hold it.

- Tapping the pen acts like a left click.
- Tap and drag acts like a click and drag: tap an object and drag and the object is moved; tap and drag across several objects and they are selected. In a drawing program, tap and drag will draw a line.
- Pressing the upper button on the pen acts like a right click.
- Pressing the lower button and dragging is like using the scroll wheel.

**Bigger tablet**

There is a bigger tablet available. The buttons don’t work in any of the apps on the AV computer, but otherwise it works the same as the small tablet. It doesn’t have a box, so it is kept in the back room.
Applications
Below are instructions for using the graphics tablet with a few common applications.

PowerPoint
You can use the pen tool as the pen in a PowerPoint presentation, which enables you to annotate the presentation as you go. See Using the Pen, above.
1. Open PowerPoint (or an existing power point presentation)
2. Make sure the projectors are on.
3. Start the presentation
4. In the lower right corner of the PowerPoint screen will be 4 buttons. Click the one that looks like a pen and select one of the pen functions (ballpoint, felt, or highlighter).
5. Draw on the screen, but be careful - a click normally advances the PowerPoint, so if you just tap the tablet, it will advance your slide.

Paint
If you just want to quick draw something for a class, Paint is probably the easiest program.
1. Open Paint
2. Drag it over to display it on the projector
3. Select the paintbrush tool
4. Select a brush size and shape (the smallest are NOT easy to see on the screen) and color
5. Draw
6. If you open a new document (e.g. if you run out of room and need a new screen) you can select new from the file menu. It will prompt you to save if you want to keep your work.
7. Please don’t forget to bring it back to the monitor before exiting the program.

Remember with the pen tool, the right side of the graphics tablet is the projector and the left half is the monitor, so you only have half the area to draw in.
Appendix 4: Canned Shows
All canned shows are in the “Shows” folder or sub folders. They are listed below in the order they appear if you choose Open from the File menu.
Run time is the time to run the show from the normal startup position, hitting RUN as soon as possible when at a PAUSE, and without skipping anything.

Retrograde Motion Folder
Retrograde: Jupiter
Activity/ies or use: useful for classes, esp. 105 & 201.
Notes:
Labels: 1 – start of show, 2 – Run 1 – full cycle, 3 – Run 2 – with stops, 12 - reset
Show Description:
Overview: Move to Ann Arbor; View a retrograde of Jupiter from start to finish; then rewind and watch it again with pauses at the start and end of retrograde.
Running the show:
Hit Run to move to Ann Arbor and an appropriate date and time and turn on the blue lights. At each PAUSE, wait until the projector finishes moving before hitting Run again until you are done with the set-up.
Hit Run to observe the entire retrograde of Jupiter without breaks, or hit JMP 3 to skip to the retrograde with breaks.
Repeat the retrograde by hitting JMP 2 for the retrograde without breaks, or JMP 3 for retrograde with breaks.
Hitting Run after completing the retrograde with breaks will run the reset, or you can hit JMP 12 at any time to skip to the reset.
Run time: approx. 3.5 minutes

Retrograde: Mars
Activity/ies or use: useful for classes, esp. 105 & 201. Included with planetary motions activities
Notes: Mars retrogrades occur ~2.25 years apart, so it can take a long time to set up or shutdown this show.
Labels & Show Description:
Same as Jupiter, above.
Run time: approx. 3.5 minutes

Retrograde: Mercury
Activity/ies or use: useful for intro classes – this is the shortest retrograde and happens a couple times per year, so it is the quickest one for a demo.
Notes:
Labels & Show Description:
Same as Jupiter, above.
Run time: approx. 2.25 minutes

Retrograde: Venus
Activity/ies or use: used in a 105 and 201 lab, as part of another show.
Notes:
Labels & Show Description:
Same as Jupiter, above.
Run time: approx. 2 minutes
Seasonal Stars folder:
Seasonal stars: Fall, Winter, Spring, Summer

Activities or use: for use with the out of season constellations and Reading a star chart activities.

Notes: all shows are identical except for the sidereal time

Labels: 1 – start of show; 3 - figures 12 - reset

Show Description:
Overview: move to Ann Arbor’s latitude and to a sidereal time appropriate for the season, switch the lights on and off appropriately to see the stars, turn the figures on and off, then reset. The times are: Fall: 19:10; Spring: 9:06; summer: 13:07; Winter: 4:11;

Running the show:
Hit Run to move to Ann Arbor and an appropriate time. Hit run again to turn on the stars and dim the lights. You can use run to turn the figures on, and then Run again to turn them off, or JMP 12 to skip to the reset. JMP 3 will let you repeat turning the figures on and off. You can use the control board to move the sky anytime between the end of the startup group and the reset.

Run time: about a minute.

Seasonal stars: All4_Fall, OutSeason_Fall, OutSeason_Winter

Activities or use: for use with the out of season constellations and Reading a star chart activities.

Notes: all shows are identical except for the sidereal time

Labels: 1 – start of show; 3 – fall; 4 – winter; 5 – Spring; 12 - summer; 12 - reset

Show Description:
Overview: move to Ann Arbor’s latitude and to a sidereal time appropriate for the first season (fall for All4_Fall, Winter for OutSeason_Fall, Spring for OutSeason_Winter), switch the lights on and off appropriately to see the stars, then reset. The times are: Fall: 19:10; Spring: 9:06; summer: 13:07; Winter: 4:11;

Running the show:
Hit Run to turn on the blue lights and move to Ann Arbor, which completes the setup. From here, you can hit run to turn on the blue lights and move to the right time, then turn on the stars and dim the lights, or JMP [2, 3, 4, or 5] to switch to a different season. JMP 12 will skip to the reset. Note if a show has a season in the show title, that season is NOT part of the show, and the JMP command will take you to the second mark instead (e.g. hitting JMP 2 in outSeason_Fall will take you to the 2 second mark.)

Run time: about a minute.

Main Shows Folder:
Calibrate

Activities or use: for calibrating the projector.

Notes: this should get you close to the needed position, unless the calibration is very off.

Labels: 1 – start of show

Show Description:
Overview: move to 45° latitude, six hours in sidereal time. Turn on the ecliptic, equator, meridian, and year counter. Turn off the white lights after a pause.

Running the show:
Run sets everything up. Another run turns off the lights. See page 13 for calibration instructions. ALWAYS FOLLOW THIS WITH SHUTDOW.ZKP to get ready for using the control board or another show.

Run time: about half a minute.
Coordinates
Activity/ies or use: Coordinate Systems activity
Notes:
Labels: 1 – start of show, 2 – Alt-Az; 3 – RA-Dec; 12 - reset
Show Description:
Overview: move to Ann Arbor. Show the stars and line needed to measure altitude and azimuth, than RA and Dec.
Running the show:
Hit Run and wait for the polar motion, and then a TIME cue to complete. Run will switch lights so you can see the stars, VERC, and AZISC. Use the control board to move in DIU and to adjust VERC so students can fill out the worksheet. Run will cause it to return to the correct date and time. Use JMP 2 to repeat the Alt-Az group, or hit run to do the RA-Dec group. JMP 3 will let you repeat the RA-Dec group. Another Run (on JMP 12, RUN) will run the reset group.
Run time: about a minute and a half.

MoonPhaseShort
Activity/ies or use: Phases of the Moon discussion version
Notes: check calibration before beginning. Do not run backwards in ANN. This show does not allow one to jump around. Also, you should run shut down before starting this show if you run any other shows, including calibrate.zkp.
Labels: 1 – start of show, 12 - reset
Show Description:
Overview: show starts at the last quarter moon at the equator. It steps forward to cover last quarter, first quarter, full, and third-quarter again. If a DIUR motion is required, it moves before ANN.
Running the show:
Students will need flashlights to fill out the worksheets. You’ll have to press RUN a couple times before you get to a last quarter moon near transit with the sun just after sunrise. Each run after that steps forward about a week to cover each phase. The date changes, then there’s a brief pause and the time changes to bring the moon up roughly to the meridian. At any time, you can hit JMP 12 to run the rest, but you can’t hop around within the show.
Run time: about 3 ½ minutes

Motions
Activity/ies or use: Planet Motions
Notes:
Labels: 1 – start of show, 12 - reset
Show Description:
Overview: Shows the motions of the planets with the Sun on the meridian, followed by the retrograde motion of Venus, and then Mars.
Show the motion of the sky over 12 hours. Show annular motion: sunrise, noon, sunset today; sunrise, noon, sunset on the December solstice; sunrise, noon, sunset on the March equinox; sunrise, noon, sunset on the June solstice. Return to today, at the equator. Move slowly 12 h. Move to -42° LAT, move slowly 12 h. return to Ann Arbor.
Run time: 22 minutes

MWDisk
Activity/ies or use: 105 lab The Milky Way Disk
Notes:
Labels: 1 – start of show, 12 - reset
Show Description:
Overview: Move to the equator, with Orion overhead. Switch lights so you can see the stars but NOT the Milky Way. Turn on MW.
Running the show:
Students will need flashlights to read their star charts and fill out the worksheets, and laser pointers to point out their stars. Otherwise it’s a very basic show: Hit Run to start it, again to switch lights to see the stars, a third time to turn on the MW, and once more to reset.
Run time: 1.25 minutes
MWStruct

Activity/ies or use: 105 lab the Milky Way Structure

Notes:
Labels: 1 – start of show, 2 – 0h LST, 3 – 8 h LST; 4 – 16h LST; 5 – N galactic pole; 12 - reset

Show Description:
Overview:
Move to the equator and observe the stars at 0h, 8h, and 16h LST, then move so the north galactic pole is at zenith.

Running the show:
Run runs setup, which moves to the equator and turns on the lights. After that, each group has 2 PAUSE cues: the first trns up the lights and moves to the correct time, the second turns down the lights. After the setup, you can use the labels to hop around to any group, or use JMP 12 to go to the reset.

Run time: 3.5 minutes

plan_intro

Activity/ies or use: An introduction

Notes:
Labels: 1 – start of show, 2 – sunset; 3 – 24 hr motion; 12 - reset

Show Description:
Overview:
Move to now in Ann Arbor, then go to sunset. Move slowly 24h. Turns on the major lines after about 30 seconds.

Running the show:
This is intended as a very basic show. The lights and stars are tied to the Sun so you can move in DIUR or ANN and have the star & planet visibility appropriate. At any PAUSE, you can use labels 2 or 3 to either get to sunset, or have it execute a 24 hour rotation.

Run time: about 4 minutes

PlanetsEcliptic

Activity/ies or use: Planets on the ecliptic

Notes:
Labels: 1 – start of show, 2- lines; 3 – inner planets; 4 - Mars 12 - reset

Show Description:
Overview:
Move to Ann Arbor. Turn on the solar system objects and run forward 24h in DIUR. Turn on lines after roughly 30 seconds, and stars after about a minute. It then shows the motion of the planets with the Sun held on the meridian, then the retrograde of Mars.

Running the show:
Setup moves to Ann Arbor. As it is making the first movement in DIUR, you'll want to point out how things are moving, that the planets are in a line, etc. During the inner planets group, have them focus on the inner planets fist, but then direct their attention to the outer planets as well, which appear to rise in the west and set in the east. For Mars, be sure to point out the geigenshein. You can use JMP commands at the end of a group, but NOT in the middle of a group.

Run time: 9 minutes
Planets105

Activities or use: 105 lab “Motions of the inner and outer planets”

Notes:

Labels: 1 – start of show; 2 – Venus steps (start); 3 – 2014/12/19; 4 – 2015/4/18; 5 – 2015/8/16; 6 – 2015/12/14; 9 – Mars retrograde; 12 - reset

Show Description:

Overview:
Move to Ann Arbor and an appropriate starting date. Step forward approximately 1 month at a time with the Sun on the meridian and Venus visible for about 2 years. Show Mars go through retrograde.

Running the show:
Students will need flashlights to do the worksheet. You must let setup complete. During the Venus steps group, you can go to any of the specific dates using JMP and the label. You can skip ahead to Mars using JMP 9, but do not try to go back into the Venus group from the Mars group.

Run time: 8 minutes

Precession

Activities or use: 105 lab Precession

Notes: There are no encoders on the precession motion, so you must reset everything by hand when you are done.

Labels: 1 – start of show, 12 - reset

Show Description:
See the activity hints for tips and instructions on running the show with the worksheet. See page 11 for instructions on setting for demonstrating precession. BE SURE TO RECALIBRATE WHEN YOU ARE DONE (see page 12.)

Seasons

Activities or use Seasons Lab (long worksheet)

Notes:

Labels 1 - start of show, Ann Arbor; 2 - Ann Arbor, Winter Solstice; 3 - Ann Arbor, Vernal Equinox; 4 - Chile; 5 - Chile, Winter Solstice; 6 - Chile, Vernal Equinox; 7 - Equator; 8 - Equator, Winter Solstice; 9 - Equator, Vernal Equinox; 10 - North Pole, 11 - North Pole, Vernal Equinox; 12 - reset

Show Description:
Overview: there are four locations: Ann Arbor, Chile, the equator, and the north pole. At all four locations, the motion of the sun is shown for the September equinox, December solstice, March equinox, and June solstice. At the North Pole, the stars will come on when the sun drops below the horizon. For all locations, the sun starts at sunrise (i.e. on the horizon) then moves ahead a small amount so the students can see exactly where it is rising. It then moves the Sun to the meridian, then to sunset.

Running the show:
See SeasonsShort for ideas about running the show. This version adds the equator and southern hemisphere, so the labels are limited.
**SeasonsShort**

**Activities or use: Seasons Lab (discussion worksheet)**

**Notes:** For each new date, the projector will move to the correct date and an hour or so early. RUN will move it to sunrise (record the time – the Sun may be too low to see yet), then 15 minutes after sunrise (record the rise position), then to the meridian (record the date as it moves, then the meridian altitude when it stops), and finally to the west horizon (record set position and time.) They can figure out hours of daylight while the projector moves to the next date.

**Labels:** 1 - start of show, Ann Arbor; 2 - Ann Arbor, Winter Solstice; 3 - Ann Arbor, Vernal Equinox; 4 - Ann Arbor, Summer Solstice; 6 - North Pole, autumnal equinox; 7 - - North Pole, Winter Solstice; 8 - North Pole, Vernal Equinox; 9 - North Pole, Summer Solstice; 12 - reset

**Show Description:**

**Overview:**
Two locations: Ann Arbor, and the north pole. At both locations, the motion of the sun is shown for the September equinox, December solstice, March equinox, and June solstice. At the North Pole, the stars will come on when the sun drops below the horizon. For all locations, the sun starts at sunrise (i.e. on the horizon) then moves ahead a small amount so the students can see exactly where it is rising. It then moves the Sun to the meridian, then to sunset.

**Running the show:**
This has a lot of ground to cover, so it works best if it is not the first thing students see in the planetarium. It is also helpful if students know the difference between solar and sidereal time.

Turn on the red cove lights so students will be able to see to write, and the cardinal direction lights. The introduction walks you through making the measurements for the worksheet.

The show starts in Ann Arbor. It should run in ANN to the correct date, then a RUN will move it to sunrise. Since our horizon is actually at about 2º, the Sun MAY NOT TURN ON yet, so be sure you know when sunrise is. Record the time. A run will step forward 15 minutes so the Sun will turn on and students can see what direction it is rising. A Run will move it to the meridian so students can tell its meridian altitude. Before the next run, make sure students are watching it: it will move to sunset, and sometimes it shuts off early. The next run will move to the date of the winter solstice, then the same steps are repeated (sunrise, 15 minutes after sunrise, noon, sunset). The same steps are repeated again for the vernal equinox and summer solstice. Any of the dates can be repeated by using JMP 1 for autumnal, JMP 2 for winter, JMP 3 for vernal, and JMP 4 for summer. After that, the projector moves to the north pole. It starts at the same date and time as it did for Ann Arbor, then moves to place the Sun on the meridian over the operator’s desk (ask if the meridian makes sense at the north pole), then a run makes it move forward 24 hours. Makes sure they watch what the Sun does. Ask if it’s really daylight. Ask them to predict what the Sun would do the next day, and what will happen when you let it go forward to the winter solstice. At the winter solstice, it will repeat the same motion (go to the date, move to the meridian, move 24 hours.) Have them predict what the Sun will do at the vernal equinox and summer solstice. Use run to finish moving to the vernal equinox and summer solstice. While at the north pole you can repeat the dates using JMP 6 for autumn, JMP 7 for winter, JMP 8 for spring, and JMP 9 for summer.

**Southern**

**Activities or use: 105 lab Southern Constellations**

**Notes:**

Labels: 1 – start of show, 2 – equator, 3 Santiago, 4 – Apr 1, 5 – Oct 1, 12 - reset

**Show Description:**

**Overview:** Shows the stars at ST 10:20 in Ann Arbor, the equator, and Santiago, then moves to several other dates.

**Running the show:**
For each location & date, the blue lights will come on while the projector is moving.

Start in Ann Arbor at 10:20 LST. In particular, point out Polaris, what is above it, and below it.

Move to the equator, then to -33º latitude (the latitude of Santiago, which has nearly the same longitude as Ann Arbor.) While at Santiago, you can use run commands to move to 11h LST and 23h LST, so you can identify all the constellations in the worksheet. At any time, JMP 1 will take you back to 10:20 LST in Ann Arbor, JMP 2 to 10:20 at the equator, and JMP 3 to 10:20 at Santiago. While at Santiago, you can use a JMP 4 or 5 to move to 11 LST or 23LST, respectively. JMP 12 takes you to the reset group.
shutdown
Activity/ies or use: use after all shows, or to reset between shows to ensure things run as expected.
Notes: be sure to check the service status and make sure the motions have actually finished before exiting Skypost.
Labels: 1 – beginning
Show Description:
Overview: Prepare the projector for shutdown.
Running the show: Hit RUN. Wait for the show to complete. Always check the SP & AP positions for ANN and DIUR before exiting to make sure they have finished. The last command before the JMP 1 sets the projector to a date and time that is good for all other shows to start from.
Run time: about 1 minute.

Surface Brightness
Activity/ies or use: 105 lab Brightness and Surface Brightness
Notes:
Labels: 1 – start of show; 2 – Angell; 3 – Detroit; 4 – Peach Mountain; 12 - reset
Show Description:
Overview: Start in Ann Arbor at 6h LST. Each group either changes the lighting or has instruction for which cove light setting to use.
Running the show:
Practice and pay attention to the REM statements! If there is a cove light command, you need to hit it BEFORE hitting RUN.
Run time: about 2 minutes

Tonight
Activity/ies or use: open house show.
Notes: If the Moon phase and position is very important, you should run shutdown between shows, or at least every other show.
Labels: 1 – start of show, 12 - reset
Show Description:
Overview: displays the sky today beginning now, moving to Sunset, backing up to two hours before sunset, setting all the lights appropriately (their brightness adjusts based on the Sun’s position), and then moving forward to 10 PM. The operator has the option of displaying figures, using the control board, or skipping to the reset group using JMP 12.
Running the show:
You need several RUN commands for the set up group. It is ready when you reach 2 hours before sunset. If you want to point out the Sun’s azimuth at sunset, turn on the cardinal direction lamps. After a Run it will move forward in DIUR to 10 pm. At this point you can use the control board to do things, including move forward in time (a good way to illustrate that Polaris is the North Star) or change latitude to the Southern Hemisphere. Run will turn CONST & ZOD on, another will turn them off again. You can repeat the figures at any time using JMP 2. One more RUN will run the reset. You can run the reset at any time using JMP 12. If the moon phase is important, or if you run ANN at all, go to the shutdown show and execute the last TIME cue before starting Tonight over again.
Run time: about two minutes.
“All off!”, 7

All Off!, 3
ANALEMA, 25
ANN.A, 10
Assisted Listening Device, 31
Audio, 28
AV applications, 31
AV System, 28

Calibrate Main Motions, 13
Calibration
   Precession, 12
Canned Shows, 35
cardinal points, 14
clock-like displays, 7
Commands, 8
   ANN, 10
   AZISC, 9
   BLUE, 9
   BWD, 8
   COM, 9
   CONST, 9
   DIUR, 10
   ECL, 9
   EQU, 9
   FIX, 9
   FWD, 8
   HOME, 8
   HORE, 9
   HOUC, 9
   HOUC.A, 10
   HOUSC, 9
   IPLAN, 9
   JMP, 8
   JU, 9
   MA, 9
   MAP, 9
   MCOM, 10
   ME, 9
   MER, 9
   MOON, 9
   MSAT, 10
   MVERT, 10
   MW, 9
   NAU, 9
   PLAN, 9
   POL, 10, 25, 26
   PRSC, 9
   SA, 9
   SAT, 9
   SPLIT, 8
   STOP, 8
   SUN, 9
   V, 8
   VE, 9
   VERC, 9
   WHITE, 9
   YC, 9
   ZOD, 9
   Computer Display, 6
   control panel, 5, 24
cove lights, 3, 5, 14, 15, 28
   crash
      Skypost, 22
      Windows, 22
cue, 24, 26
dials, 7
   Dimming functions, 8, 9, 24
   Display window, 7
   DIUR.A, 10
diurnal motion, 10
dome lighting, 3, 14
   DVDs, 30
   Edit mode, 7
   Good Practices, 3
   Graphics tablet, 32
      buttons, 32
      mouse, 32
      Paint, 34
      Pen, 33
      PowerPoint, 34
   Hints, 3
   initialization, 3, 4
   in-use light, 14
   jump, 8
   Keyboard, 24
   label, 8
   latitude, 7
   Lighting, 14
   Lights
      cardinal points, 14
      cove lights, 15
      in-use light, 14
      operator light, 14
      log book, 3, 5
   Main Switch, 4, 5
   major motion, 7
   Major Motions, 25
   MERIDIAN, 25
   mode, 5, 30, 31
motions, 9, 10, 25
Minor, 10

NOW, 25

Operation
control panel, 8
Keyboard, 24
operator light, 14

Planetarium won’t start, 16
POL.A, 10
polar altitude, 7
polar motion, 10
potentiometers, 8, 12
  Re-mapping, 12
Powerpoint, 30
precession, 11, 12
Problems, 42

Rebooting, 23
Reporting Problems, 42
Rules, 1
RUN, 5, 7, 8

Seating, 27

service status, 3, 6
show, 5, 7, 8, 11, 13, 30, 35, 36, 37, 38
shutdown.zkp, 3, 5
sidereal time, 7
SKYPOST, 4
speed, 8
Starting Up, 4
Superordinate functions, 8
superordinte functions, 24
Switch functions, 8, 9, 24

temperature, 1
title bar, 7
toolbar, 7
Troubleshooting, 16
  computer problems, 22
  Control Panel, 19, 22
  lights/lamps, 21
  Show won’t run, 20
  wrong positions, 21

velocity, 8
virtual control panel, 7

Windows, 3, 28, 31
Reporting Problems

Emergencies:
Emergencies involving people, fire, etc: call 911 from the phone in the foyer. If you use a cell phone, tell them immediately you are calling from a UM building and they will transfer you. When it is safe to do so, contact Shannon (615-1584) or the main department number (764-3440) to let someone know what happened (we really don’t like learning about these things from the evening news).

Emergencies with the projector, computer, etc: the emergency contact list is on the bulletin board in the AV room.

Problems and other issues:
You can do any of the following:
   - Email astro-labs@umich.edu
   - Open a browser window on the AV computer and fill out the trouble report form or click “Report Problems” in the bookmark bar.
   - Log in to Request.lsa.umich.edu/astrology/labs and fill out the form